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1. Introduction 
 
 

1.1 Purpose 

The purpose of this document is to assist suppliers with the generation of a valid Excel spreadsheet to create or maintain 
their catalog items in FedMall. 

 
 

1.2 Audience 

The intended audience of this planning document is: 

 FedMall Suppliers 

 FedMall Program Managers 

 Communication Leads 
 
 

1.3 Document References 

This document is based on the following documents: 
 

Document Name Version Owner 

FedMall Supplier Catalog Template Spreadsheet V1.1  
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2 Instructions 
 
 

2.1 Summary of Procedure 

 Complete the “Catalog Template” sheet with your catalog details. Do not modify the number or the order of 
the columns. 

 Reference the “Field Descriptions” sheet and the “Additional Information” sheet for help on completing the 
data entry. You may leave optional fields blank. 

 If the item already exists in FedMall, it will be overwritten. If it does not already exist in FedMall, it will be 
added. To delete an item, enter a “Y” in the first column (Archive); otherwise, leave the first column blank (or 
specify “N” in the first column). 

 When complete, upload the file to FedMall via the Supplier Portal. 
 
 

2.2 Catalog File Details 
 

File Type The file must be one of the following formats: 

(1) Plain text file with a .csv extension 
(2) Excel file (97-2003 format) with a .xls extension 
(3) Excel file with a .xlsx extension 

Row Header Use the headings on the “Catalog Template” sheet. The uploaded file must include the headings as its first 
row. 

Field Delimiter If creating a plain text .csv file, each field should be separated from adjacent fields with a delimiter, which is 
the caret ( ^ ) character. If you want to use Microsoft Excel to create your data file and then export it to 
delimited plain text file, instructions are provided below in section 2.5. 

Rows You may insert as many rows of data as will fit in the maximum file size (see below). 

File Size The size of the file will vary not only with the number of rows of data, but also with the content of each row. 
The file may not exceed a maximum size of 100 million bytes (about 100 Megabytes). 

File Name The file name must be less than 128 characters and cannot contain a caret ( ^ ) character. 

 
 
 

2.3 Managing Images 

All images are uploaded in an archive (.zip) file separate from the main catalog spreadsheet. Please see the “Image 
Upload Specification” document for complete details about how to structure that image file archive. 

 
 

2.4 Using MRCs to Specify Additional Characteristics 

The final field in the template, “Characteristic Information,” represents a series of code-value pairs, where the code is a 
Master Requirements Code (MRC) as listed in the Master Requirements Directory (MRD), which in turn is managed by 
the Defense Logistics Agency (DLA) Logistics Information Services (DLIS). 

If you don’t already know a specific MRC code, you may search for individual codes in the Supplier Portal by accessing 
Product Information Management and adding/editing an item. 
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2.5 Formatting instructions for creating a .xls or .xlsx file 

If you are creating a .xls or .xlsx file, the worksheet containing the catalog data must be the first sheet in the spreadsheet. When 
uploading .xls or .xlsx files, all worksheets within the file are ignored except for the first worksheet. 

If necessary, you can move the catalog data worksheet by simply dragging the worksheet tab to the front of the other worksheet 
tabs contained within your spreadsheet. 

 
 

2.6 Formatting instructions for creating a .csv file 

If you are creating a .csv data file, special care needs to be taken to ensure that the proper formatting is used in the data file. Please 
see the following sections for details on this formatting. 

 

2.6.1 Managing Number and Date Formats in Excel 
 

If you are using Microsoft Excel to edit your data file (.csv), Excel may try to automatically convert the format of your numbers and 
dates from the required format. Examples include: 

 Long numbers: If you enter a very long value, such as a part number, that only contains the digits 0-9, Excel may try to 
interpret this as a long number and display it in scientific notation (e.g., “1234567890123” would display as 
“1.23457E+12”). 

 Dates: If you enter a value that Excel believes is a date, it will attempt to convert the value to its own format (e.g., “2017- 
01-24”, which is in the correct format, may be changed to “1/24/17” by Excel). 

 Values with a leading zero: Excel will recognize that a CAGE code or part number with letters in it is text, e.g., “012AB”; 
however, if the value is all-numeric and starts with a zero, Excel will treat it as a number and trim the leading zero (e.g., 
“02468” is converted to “2468”). 

Essentially, in all of these examples, Excel is attempting to format your data for you, when you want the data to be stored exactly as 
you enter it. 

 

2.6.1.1 First step: Understand the format that is actually saved in your file 

If you have an existing .csv file, the way to ensure that you understand what is actually in that file is to open it in a plain text editor, 
such as Notepad, rather than in Excel. To do this, you may choose one of these options: 

 Open Notepad (from the Start menu), then select File -> Open, and open the .csv file. 
 From Windows Explorer, right-click the file, select “Open With…” and then choose Notepad (or another text editor, such 

as Notepad++). 

 
 

2.6.1.2 Entering new data into a template 

If you are creating a new catalog from scratch, you will want to start with a template. FedMall provides a sample template in 
addition to this Quick Start Guide. Before entering data into a blank cell, ensure that the format is correctly set to “Text.” Change 
the format of the cell(s) in question to “Text” instead of “General” or “Date.” You may do this globally for all cells in the template 
you are working with. (Hint: to select all cells at once, click any cell, and then tap Ctrl-A on your keyboard.) 
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2.6.1.3 Working with an existing file 

If you already have a .csv file and you open it in Excel, you may notice that Excel converts the values to their numeric and date 
formats automatically. This may happen when you open the .csv file: (1) from Excel’s File -> Open menu, or (2) by double-clicking on 
the .csv file in Windows Explorer to open it in Excel. 

To avoid this issue, you may want to import the data when you open the file, rather than opening it directly. To do this, open Excel 
to a blank workbook. Before you import your data, set all fields in the worksheet to Text (as described in section 2.6.1.2), and select 
the “Get Data from Text” option from the Data tab. 

 

Select your .csv file in the Open dialog box, and then proceed through the steps of the Text Import Wizard. In Step 1, choose 
“Delimited” and select the check box next to “My data has headers.” 
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In Step 2, specify that the delimiter is a caret ( ^ ) by checking the “Other” box and typing a caret in the blank field. 
 

In Step 3, you may leave the default settings (“General”) for most fields, because you already set all fields to “Text” before you 
started the import wizard. However, Excel will still try to convert the date formats, so be explicit for the Sale Start Date and Sale End 
Date by selecting each of those columns in turn and choosing “Text” from the list of column data formats. 

 

In the final step, you will be able to select where the imported data should go (e.g., cell A1 of your current, blank spreadsheet). 

Your imported data will now be presented as all text values. 

2.6.2 Exporting a Text File from Excel 
 

You may create your catalog file in any text editor. You may also find it convenient to use Excel to maintain your data and then 
export the data from Excel to the delimited text file for import into FedMall. 

 First, change your delimiter (“list separator”). Open Control Panel and then the “Region and Language” applet (or, click 
Start -> Run and type “intl.cpl”). On the Formats tab, click “Additional settings…”. Change the “List separator” value from 
its default (usually a comma) to the caret (Shift + 6 on most US keyboards). Click OK to save the change. 
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 In Excel, create your catalog. Ensure that the first row contains the column headers as listed in the “Catalog Template” 
sheet. Click File -> Save As. In Save As Type, select “CSV (Comma delimited) (*.csv)”. Provide a file name and click Save. 
Excel will warn you that “some features in your workbook might be lost”; click Yes to keep using this format (Excel is 
warning you that some features, like formatting, won’t be saved in a text file; this is to be expected). 

 Confirm a successful export by opening the file in a plain text editor (such as Notepad). You should see the header row on 
the first line followed by your data, with a caret ( ^ ) character separating each data field (“column”). 

 

2.6.3 Maintaining Delimiters with Optional Fields 
 

There must be a caret separating each field, even if an optional field is left blank. For example, if leaving OEM CAGE Code blank 
(between OEM Part Number and OEM Name), the fields might look like this: 

…^PN12345^^Company Name^… 

This same principle holds true at the end of the row. For example, if you leave the last five fields blank in a given row, that row 
would end with five carets (^^^^^), like this: 

…^This item meets environmental regulations^^^^^ 
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2.6.4 Example 
 

The first row of your .csv text file is a header row, and it should look like this: 
 

 

After including the header row on line 1 of your file, include one item record on each subsequent line (beginning with line 2) of the 
file. The following text represents two well-formed records that will pass file upload validations (although of course the CAGE code 
and contract number are fictitious). The first sample record only includes the mandatory fields; the second record has all fields 
completed. 

 

Item Master Primary Spec/Item Status Information/Archive^Item Master Primary Spec/Common 
Information/Commercial and Government Entity Code^Item Master Primary Spec/Common Information/Contract 
Number^Item Master Primary Spec/Common Information/Part Number^Item Master Primary Spec/Common 
Information/Part Name^Item Master Primary Spec/Common Information/Federal Supply Class^Item Master Primary 
Spec/Pricing/Original Unit Price^Item Master Primary Spec/Pricing/Original Unit of Issue^Item Master Primary 
Spec/Pricing/Quantity Per Unit Pack^Item Master Primary Spec/Common Information/Original Equipment 
Manufacturer Part Number^Item Master Primary Spec/Common Information/Original Equipment Manufacturer CAGE 
Code^Item Master Primary Spec/Common Information/Original Equipment Manufacturer Name^Item Master Primary 
Spec/Short Description^Item Master Primary Spec/Common Information/Days After Receipt of Order^Item Master 
Primary Spec/Long Description^Item Master Primary Spec/Common Information/Universal Product Code^Item Master 
Primary Spec/Commercial Information/Environmental Information/Hazardous Material Flag^Item Master Primary 
Spec/Sale Pricing/Sale Start Date^Item Master Primary Spec/Sale Pricing/Sale End Date^Item Master Primary Spec/Sale 
Pricing/Sale Price^Item Master Primary Spec/Commercial Information/Shipping Information/Shipment Level of 
Service/Standard Shipment Price^Item Master Primary Spec/Commercial Information/Shipping Information/Shipment 
Level of Service/Expedited Shipment Price^Item Master Primary Spec/Commercial Information/Shipping 
Information/Shipment Level of Service/Next Day Shipment Price^Item Master Primary Spec/Special 
Properties/Environmentally Preferred/Environmentally Preferred Indicator^Item Master Primary Spec/Special 
Properties/Environmentally Preferred/Justifying Comment^Item Master Primary Spec/Special Properties/Energy 
Star/Energy Star Indicator^Item Master Primary Spec/Special Properties/Energy Star/Justifying Comment^Item Master 
Primary Spec/Special Properties/Made in the USA/Made in the USA Indicator^Item Master Primary Spec/Special 
Properties/Made in the USA/Justifying Comment^Item Master Primary Spec/Characteristic Information 

N^AB123^MARKETPLACE_AB123^PN12345^Stamp, 6 Digit Numbr Pro^7510^20.83^EA^1^USST5546^^U. S. STAMP & 
SIGN^Professional Numberer, Self-Inking, Type Size 1 1/2, Six Digits, Black^2^Strong and fast to tackle even the biggest 
numbering jobs. Steel frame construction stands up to heavy-duty use. A self-inking pad saves time; there's no need to 
stop and re-ink. Includes replaceable stamp pad that delivers up to 10,000 impressions. Stamp Type: Numberer; Ink 
Types: Self-Inking; Impression Width: 1 5/8 inch; Impression Height: 3/8 inch.^^^^^^^^^^^^^^^ 

N^AB123^MARKETPLACE_AB123^123ABC45^Label, Heat Shrink, 1/4-inch, 
White^7510^35.57^RO^1^DYM18051^A1B2C^SANFORD LP^Rhino Heat Shrink Tubes Industrial Label Tape Cassette, 
1/4 IN X 5 FT, White^1^Durable and smear-proof. Resistant to chemicals, solvents, grease, heat, moisture and other 
harsh elements. Industrial-strength adhesive for labels that stick and stay stuck. Easy-to-peel split backing for simple 
application. Label Size - text: 1/4 in x 5 ft.; Label Color(s): White; Machine Compatibility: Label Makers; Printed Text 
Color(s): Black.^71701180513^N^2017-01-01^2017-09-30^29.82^4.99^9.99^14.99^Y^This item is Green 
Certified^Y^This item received Energy Star Certification in 2017^Y^Manufactured in California with materials sourced 
from Maryland^AAAB|white~~~~~CGCY|Office supplies~~~~~ABGL|0.25 inches~~~~~ASHR|Varies 
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3 Field Descriptions 

The following table provides descriptions of columns in the Supplier Catalog Template. 

 
 

3.1 Notes 

 Under Req? (i.e., Required?), options are: 
o N: No, not required. If this optional field isn’t included, you will still need to include the delimiter ( ^ ) between fields. 
o Y: Yes, required field. Must be included for each row. 
o C: Conditionally required field. Must be included if another field is provided; see the field description for more 

information. 

 Do not include a carat ( ^ ) or a pipe ( | ) within any field (e.g. within a description) in the file, except as a 
delimiter as specified in this document. 

 Note that the Characteristic Information field (the very last field) may include more than one characteristic 
within the single field. See the field description for details about how to separate the characteristic (MRC 
Code) from its value for each characteristic. 

 Because this is a text file, all values (including numbers) are stored as text. If using a spreadsheet to capture 
this data, ensure that you are setting the format of all fields as “text.” 

 Ensure that no fields include non-printable characters or any white space other than a standard space. 
Do not include carriage returns or line feeds within the description fields. 

 
 

3.2 Fields 
 

Field Name 
Position 

Field Description Format Length Req 
? 

Attribute Header (matches 
the column headers in the 
“Catalog Template” sheet) 

Archive 1 This field indicates whether the item 
should be marked for deletion (archive). 
Valid values are “Y” (yes, archive; mark 
as deleted in the database) or “N” (no, 
default). 

1 letter 
{Y, N} 

1 N Item Master Primary 
Spec/Item Status 
Information/Archive 

Commercial and 
Government 
Entity Code 

2 The CAGE code of the supplier; a 5- 
character alphanumeric code issued by 
the US Government 

Exactly 5 uppercase 
letters and/or 
numbers 

{A-Z, 0-9} 

5 Y Item Master Primary 
Spec/Common 
Information/Commercial 
and Government Entity 
Code 

Contract 
Number 

3 The full contract number associated with 
this item’s catalog. For MarketPlace 
catalogs without a contract, use the 
identifier MARKETPLACE_<CAGE>. That 
is, a single underscore character ( _ ) 
separates the all-capital word 
“MARKETPLACE” from the supplier’s 
CAGE code (5 alphanumeric characters). 
Example: MARKETPLACE_012AB. 

Uppercase letters 
and/or numbers; 
underscore is 
allowed for 
MarketPlace. No 
hyphens. 
{A-Z, 0-9, _} 

20 Y Item Master Primary 
Spec/Common 
Information/Contract 
Number 

Part Number 4 Your part number; the part number as 
captured by the vendor/supplier. 
Note: Part Numbers must be unique 
throughout the file and should not be 
duplicated within the same file. 

Letters and/or 
numbers and/or 
hyphen. 

{A-Z, a-z, 0-9, -} 

80 Y Item Master Primary 
Spec/Common 
Information/Part Number 

Part Name 5 Product name; the name of the item General text; do not 

use caret ( ^ ) or pipe 
( | ) 

80 Y Item Master Primary 
Spec/Common 
Information/Part Name 
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Field Name 
Position 

Field Description Format Length Req 
? 

Attribute Header (matches 
the column headers in the 
“Catalog Template” sheet) 

Product Service 
Code 

6 The PSC (product service code) includes 
all of the Federal Service Code (FSC) 
numbers and includes additional codes; 
PSCs are 4 alphanumeric characters 
long. 

Exactly 4 uppercase 
letters and/or 
numbers 

{A-Z, 0-9} 

4 Y Item Master Primary 
Spec/Common 
Information/Federal Supply 
Class 

Price 7 This is the customer cost; note: for FOB 
Destination, this price must include the 
shipment costs. Enter the price as a 
number with up to two decimal digits; 
do not include the dollar sign. 

Numbers and 
decimal point (no 
commas or dollar 
sign). 
{0-9, .} 

20 Y Item Master Primary 
Spec/Pricing/Original Unit 
Price 

Unit of Issue 8 This is a word such as “each,” “box,” or 
“carton,” to describe the unit associated 
with the quantity. Use a valid code from 
the list provided in the next sheet. 

Uppercase letters 
and/or numbers 
{A-Z, 0-9} 

2 Y Item Master Primary 
Spec/Pricing/Original Unit 
of Issue 

Quantity per 
Unit Pack 

9 Also known as the quantity per unit of 
issue; this is the number of items in each 
box, carton, etc. 

Whole number 
{0-9} 

20 Y Item Master Primary 
Spec/Pricing/Quantity Per 
Unit Pack 

OEM Part 
Number 

10 The original equipment manufacturer 
(OEM) part number; do not modify with 
a prefix or suffix 

General text; do not 
use caret ( ^ ) or pipe 
( | ) 

80 Y Item Master Primary 
Spec/Common 
Information/Original 
Equipment Manufacturer 
Part Number 

OEM CAGE Code 11 The original equipment manufacturer 
(OEM)’s 5-character Commercial and 
Government Entity (CAGE) code 

Exactly 5 uppercase 
letters and/or 
numbers 
{A-Z, 0-9} 

5 N Item Master Primary 
Spec/Common 
Information/Original 
Equipment Manufacturer 
CAGE Code 

OEM Name 12 The original equipment manufacturer 
(OEM) name; the name of the company 
that manufactured the item 

General text; do not 
use caret ( ^ ) or pipe 
( | ) 

80 Y Item Master Primary 
Spec/Common 
Information/Original 
Equipment Manufacturer 
Name 

Description 13 Detailed description of the item (spell 
out key words) 

General text; do not 
use caret ( ^ ) or pipe 
( | ) 

254 Y Item Master Primary 
Spec/Short Description 

Days ARO 14 Time frame from receipt of order (ARO = 
After Receipt of Order) to shipping; this 
is not the same as the time frame for the 
delivery of an order. 

Whole number 
{0-9} 

20 Y Item Master Primary 
Spec/Common 
Information/Days After 
Receipt of Order 

Expanded 
Description 

15 Long description of the item. General text; do not 
use caret ( ^ ) or pipe 
( | ) 

3000 Y Item Master Primary 
Spec/Long Description 

UPC 16 The universal product code (“bar code”) 
number. Use only digits 0 through 9; do 
not include the hyphen (-) character. 

Numerals only (do 
not use hyphens). 
{0-9} 

12 N Item Master Primary 
Spec/Common 
Information/Universal 
Product Code 

Hazardous 
Material Flag 

17 Indicates hazardous material (HAZMAT) 
classification. Valid values are “Y” (yes, 
HAZMAT) or “N” (no). 

1 letter 
{Y, N} 

1 N Item Master Primary 
Spec/Commercial 
Information/Environmental 
Information/Hazardous 
Material Flag 

Sale Start Date 18 The date (date only, no time) at which 
point the sale price will be effective. Use 
format YYYY-MM-DD, e.g., 2015-12-17. 

Note: If using Microsoft Excel to create a 
.csv file , change the format to “Text” 
(instead of “Date” or “General”) to 
prevent Excel from converting the 
numbers into its own data format. 

Numerals and 
hyphens only. 
{0-9, -} 

10 N Item Master Primary 
Spec/Sale Pricing/Sale Start 
Date 
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Field Name 
Position 

Field Description Format Length Req 
? 

Attribute Header (matches 
the column headers in the 
“Catalog Template” sheet) 

Sale End Date 19 The date (date only, no time) at which 
point the sale price will no longer be 
effective. Use format YYYY-MM-DD, e.g., 
2015-12-17. Note: If using Microsoft 
Excel to create a .csv file, change the 
format to “Text” (instead of “Date” or 
“General”) to prevent Excel from 
converting the numbers into its own 
data format. 

Numerals and 
hyphens only. 
{0-9, -} 

10 N Item Master Primary 
Spec/Sale Pricing/Sale End 
Date 

Sale Price 20 Enter the price as a number with up to 
two decimal digits; do not include the 
dollar sign. 

Numbers and 
decimal point (no 
commas or dollar 
sign). 
{0-9, .} 

20 N Item Master Primary 
Spec/Sale Pricing/Sale Price 

Standard 
Shipment Price 

21 Enter the price as a number with up to 
two digits after the decimal; do not 
include the dollar sign. 

Numbers and 
decimal point (no 
commas or dollar 
sign). 
{0-9, .} 

10 N Item Master Primary 
Spec/Commercial 
Information/Shipping 
Information/Shipment Level 
of Service/Standard 
Shipment Price 

Expedited 
Shipment Price 

22 Enter the price as a number with up to 
two digits after the decimal; do not 
include the dollar sign. 

Numbers and 
decimal point (no 
commas or dollar 
sign). 
{0-9, .} 

10 N Item Master Primary 
Spec/Commercial 
Information/Shipping 
Information/Shipment Level 
of Service/Expedited 
Shipment Price 

Next Day 
Shipment Price 

23 Enter the price as a number with up to 
two digits after the decimal; do not 
include the dollar sign. 

Numbers and 
decimal point (no 
commas or dollar 
sign). 
{0-9, .} 

10 N Item Master Primary 
Spec/Commercial 
Information/Shipping 
Information/Shipment Level 
of Service/Next Day 
Shipment Price 

Environmentally 
Preferred 
Indicator 

24 Indicates whether this item is 
environmentally preferred. Valid values 
are “Y” (yes) or “N” (no). 

1 letter 
{Y, N} 

1 N Item Master Primary 
Spec/Special 
Properties/Environmentally 
Preferred/Environmentally 
Preferred Indicator 

Environmentally 
Preferred 
Justifying 
Comment 

25 Free text comments to justify the 
indicator. Required only if the associated 
indicator is “Y”; otherwise, leave blank. 

General text; do not 
use caret ( ^ ) or pipe 
( | ) 

3000 C Item Master Primary 
Spec/Special 
Properties/Environmentally 
Preferred/Justifying 
Comment 

Energy Star 
Indicator 

26 Indicates whether this item is Energy 
Star certified. Valid values are “Y” (yes) 
or “N” (no). 

1 letter 
{Y, N} 

1 N Item Master Primary 
Spec/Special 
Properties/Energy 
Star/Energy Star Indicator 

Energy Star 
Justifying 
Comment 

27 Free text comments to justify the 
indicator. Required only if the associated 
indicator is “Y”; otherwise, leave blank. 

General text; do not 
use caret ( ^ ) or pipe 
( | ) 

3000 C Item Master Primary 
Spec/Special 
Properties/Energy 
Star/Justifying Comment 

Made in the USA 
Indicator 

28 Indicates whether this item is made in 
the USA. Valid values are “Y” (yes) or 
“N” (no). 

1 letter 
{Y, N} 

1 N Item Master Primary 
Spec/Special 
Properties/Made in the 
USA/Made in the USA 
Indicator 

Made in the USA 
Justifying 
Comment 

29 Free text comments to justify the 
indicator. Required only if the associated 
indicator is “Y”; otherwise, leave blank. 

General text; do not 
use caret ( ^ ) or pipe 
( | ) 

3000 C Item Master Primary 
Spec/Special 
Properties/Made in the 
USA/Justifying Comment 
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Field Name 
Position 

Field Description Format Length Req 
? 

Attribute Header (matches 
the column headers in the 
“Catalog Template” sheet) 

Characteristic 
Information 

30 List of Master Requirement Codes 
(MRC). Format string as one or more 
code-value pairs. Separate the code 
from its value with the pipe (|) 
character. Separate each code-value pair 
with five (5) tilde characters (~~~~~). 
Format is: 
code1|value1~~~~~code2|value2~~~~~ 
code3|value3~~~~~code4|value4. Do 
not use the delimiters (i.e., the pipe 
character or five consecutive tildes) in 
either the codes or the values provided. 
A maximum of 100 code-value pairs may 
be included per item. 

Code: 4 uppercase 
letters. {A-Z} 
Value: General text; 
do not use caret ( ^ ) 
or pipe ( | ). 

13595 N Item Master Primary 
Spec/Characteristic 
Information 
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4 Additional Information: X12 Codes 
 
 

4.1 Overview 

FedMall uses X12 codes on all outbound requisitions and purchase orders. For those vendors who are using the DoD codes, please 
use the conversions available in the table below. All codes in vendor catalog uploads should be X12 codes as listed below. 

 
 

4.2 Notes 

Number of codes: 485 

Reference URL: http://www.dlmso.dla.mil/eApplications/LogDataAdmin/dlmsansiconverguides.asp 

 
 

4.3 Codes 

Notes: The following note is provided verbatim from the source document on the DLA.mil site: 
ALL X12 CODE VALUES WITHOUT TRAILING ASTERISKS (*) HAVE BEEN APPROVED BY THE ASC X12 COMMITTEE FOR USE IN 
ALL VERSION RELEASES OF ANSI X12. A SINGLE ASTERISK (*) INDICATES THAT X12 CODE VALUES ARE AUTHORIZED FOR USE 
IN VERSION RELEASES 005020 AND AN ALL SUBSEQUENT VERSIONS. THE X12 CODE VALUES FOLLOWED BY A DOUBLE 
ASTERISK (**) HAVE BEEN APPROVED FOR VERSION RELEASE 005030 AND ALL SUBSEQUENT VERSIONS. 

 
 

DOD CODE 
(for reference only) 

NAME/DEFINITION X12 CODE 
(to be used in FedMall) 

SC SECOND 3 

5 LIFT 5 

7 STRAND 7 

9 TIRE 9 

GP GROUP 10 

OT OUTFIT 11 

PZ PACKET 12 

RA RATION 13 

SO SHOT 14 

SX STICK 15 

17 100 POUND DRUM 17 

18 55 GALLON DRUM 18 

19 TANK TRUCK 19 

1N COUNT 1N 

1O SEASON 1O 

1P TANK CAR 1P 

FR FRAME 1Q 

1R TRANSACTION 1R 

1X QUARTER MILE 1X 

20 20 FOOT CONTAINER 20 

21 40 FOOT CONTAINER 21 

2D SHIP SET 2D 

MB BRITISH THERMAL UNITS/HOUR 2I 

http://www.dlmso.dla.mil/eApplications/LogDataAdmin/dlmsansiconverguides.asp
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DB DECIBEL 2N 

KC KILOCURIE 2R 

2U MEGAGRAM 2U 

2W BIN 2W 

43 SUPER BULK BAG (SAME SIZE AS PALLET) 43 

44 500 KILOGRAM BULK BAG 44 

45 300 KILOGRAM BULK BAG 45 

46 25 KILOGRAM BULK BAG 46 

47 50 POUND BAG 47 

48 BULK CAR LOAD 48 

4A BOBBIN 4A 

4B CAP 4B 

4E 20-PACK 4E 

4F 100-PACK 4F 

4G MICROLITER 4G 

51 ACTUAL TONNES 51 

57 MESH 57 

58 NET KILOGRAMS 58 

5B BATCH 5B 

5D PROOF GALLONS 5D 

5G PUMP 5G 

5H STAGE 5H 

5I STANDARD CUBE FOOT 5I 

VT VOLT 70 

7A LANDINGS 7A 

7C FLIGHT HOURS 7C 

8C CORD 8C 

8D DUTY 8D 

8P PROJECT 8P 

8R PROGRAM 8R 

8S SESSION 8S 

K2 SQUARE KILOMETER 8U 

91 STOKE 91 

94 CURL UNIT 94 

95 20,000 GALLON TANKCAR 95 

96 10,000 GALLON TANKCAR 96 

97 10 KILOGRAM DRUM 97 

98 15 KILOGRAM DRUM 98 

WT WATT 99 

AP APOTHECARY POUND 9A (X12 VERSION RELEASE 005020 
MIGRATION CODE. REFER TO ADC 1008.) 

BQ BRIQUET 9B (X12 VERSION RELEASE 005020 
MIGRATION CODE. REFER TO ADC 1008.) 

FD FOLD 9F (X12 VERSION RELEASE 005020 
MIGRATION CODE. REFER TO ADC 1008.) 
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AO APOTHECARY OUNCE 9O (X12 VERSION RELEASE 005020 
MIGRATION CODE. REFER TO ADC 1008.) 

PI PILLOW 9P (X12 VERSION RELEASE 005030 
MIGRATION CODE. REFER TO ADC 1008.) 

ST SEAT 9S (X12 VERSION RELEASE 005020 
MIGRATION CODE. REFER TO ADC 1008.) 

9Y FAMILY UNIT 9Y 

US USP UNIT 9Z (X12 VERSION RELEASE 005020 
MIGRATION CODE. REFER TO ADC 1008.) 

BA BALL AA 

AB BULK PACK AB 

AC ACRE AC 

YT BYTE AD 

CG CENTIGRAM AF 

AJ COP (CYLINDRICAL OR CONICAL MASS) AJ 

FA FATHOM AK 

AL ACCESS LINES AL 

AM AMPOULE AM 

AR SUPPOSITORY AR 

AT ASSORTMENT AS 

AV CAPSULE AV 

AW POWDER-FILLED VIAL AW 

AX TWENTY AX 

AY ASSEMBLY AY 

B0 BRITISH THERMAL UNITS PER CUBIC FOOT B0 

BY BUNK B2 

B3 BATTING POUND B3 

B4 BARREL IMPERIAL B4 

B5 BILLET B5 

B6 BUN B6 

B7 CYCLE B7 

B8 BOARD B8 

B9 BATT B9 

BE BALE BA 

BB BASS BOX BB 

BC BUCKET BC 

BD BUNDLE BD 

BM BEAM BE 

BF BOARD FOOT BF 

BG BAG BG 

BH BRUSH BH 

BR BAR BI 

BJ BAND BJ 

BK BOOK BK 

BZ BLOCK BL 

BO BOLT BM 
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BN BULK BN 

BT BOTTLE BO 

BP 100 BOARD FEET BP 

BL BARREL BR 

BS BASKET BS 

BI BELT BT 

BU BUSHEL (32 DRY QUARTS) BU 

BV BUSHEL DRY IMPERIAL BV 

BW BASE WEIGHT BW 

BX BOX BX 

ZF MILLION BTUS/DEKATHERM BZ 

C0 CALLS C0 

C1 COMPOSITE PRODUCT POUNDS (TOTAL WEIGHT) C1 

C7 CARSET C2 

C4 CARLOAD C4 

C5 COST C5 

C6 CELL C6 

C8 CUBIC DECIMETER C8 

C9 COIL GROUP C9 

CS CASE CA 

CB CARBOY CB 

CC CUBIC CENTIMETER CC 

KR KARAT (CARAT) CD 

CF CUBIC FOOT CF 

CQ CARD CG 

CO CONTAINER CH 

CI CUBIC INCH CI 

CE CONE CJ 

CR CONNECTOR CK 

CY CYLINDER CL 

CM CENTIMETER CM 

CN CAN CN 

CP CRATE CP 

CA CARTRIDGE CQ 

CZ CUBIC METER CR 

CX CASSETTE CS 

CT CARTON CT 

CU CUP CU 

CV COVER CV 

HP HUNDRED POUNDS CW 

CL COIL CX 

CD CUBIC YARD CY 

C3 COMBO CZ 

DA DAY DA 

DM DRAM DF 
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DG DECIGRAM DG 

MI MILE DH 

DI DISPENSER DI 

DC DECAGRAM DJ 

KM KILOMETER DK 

DL DECILITER DL 

DE DECIMETER DM 

DO DOLLARS U.S. DO 

DP DOZEN PAIR DP 

DQ DATA RECORD DQ 

DR DRUM DR 

DS DISPLAY DS 

DT DRY TON DT 

DU DYNE DU 

DK DEGREES, KELVIN DV 

DX CALENDAR DAYS (NUMBER OF) DW 

DY DIRECTORY BOOKS DY 

DZ DOZEN DZ 

E1 HECTOMETER E1 

EA EACH EA 

EB ELECTRONIC MAIL BOXES EB 

EE EMPLOYEES EE 

EH KNOTS EH 

EJ LOCATIONS EJ 

EP ELEVEN PACK EP 

EQ EQUIVALENT GALLONS EQ 

EV ENVELOPES EV 

IU INTERNATIONAL UNIT F2 

F4 MINIM F4 

F6 PRICE PER SHARE F6 

DF FAHRENHEIT FA 

FB FIELDS FB 

FC 1000 CUBIC FEET FC 

FE TRACK FOOT FE 

FF HUNDRED CUBIC METERS FF 

FG TRANSDERMAL PATCH FG 

FJ SIZING FACTOR FJ 

FK FIBER FK 

FL FLAKE TON FL 

FM MILLION CUBIC FEET FM 

FO FLUID OUNCE FO 

FT FOOT FT 

FU FURLONG FU 

GB GALLONS PER MINUTE G2 

GI GILL (IMPERIAL) G5 
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GL GALLON GA 

GG GREAT GROSS GG 

IG IMPERIAL GALLON GI 

GM GRAM GR 

GR GROSS GS 

GN GRAIN GX 

H2 HALF LITER H2 

H4 HECTOLITER H4 

HK HANK HA 

HX HUNDRED BOXES HB 

HC HUNDRED COUNT HC 

HZ HALF DOZEN HD 

HF HUNDRED FEET HF 

HG HECTOGRAM HG 

HA HUNDRED CUBIC FEET HH 

HI HUNDRED SHEETS HI 

KH HUNDREDS OF KILOGRAMS HK 

HL HUNDRED FEET (LINEAR) HL 

HO HUNDRED TROY OUNCES HO 

HQ HECTARE HQ 

HR HOUR HR 

HS HUNDRED SQUARE FEET HS 

HT HALF HOUR HT 

HD HUNDRED HU 

HW HUNDRED WEIGHT – SHORT (HUNDRED WEIGHT) HV 

CW HUNDRED WEIGHT (LONG) HW 

HB HOSPITAL BEDS HX (X12 VERSION RELEASE 005020 
MIGRATION CODE. REFER TO ADC 1008.) 

HY HUNDRED YARDS HY 

I1 PERSONS, CAPACITY  

PX PELLET I2 (X12 VERSION RELEASE 005030 
MIGRATION CODE. REFER TO ADC 1008.) 

PN PERSON IE 

IH INHALER IH 

IM IMPRESSION IM 

IN INCH IN 

IP INSURANCE POLICY IP 

IS STOP IS 

JB JOB JA 

JU JUMBO JB 

JO JOINT JO 

JR JAR JR 

JG JUG JU 

K6 KILOLITER K6 

K7 KILOWATT K7 
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KV KILOVOLT K8 (X12 VERSION RELEASE 006050 
MIGRATION CODE. REFER TO ADC 1008.) 

CK CAKE KA 

KE KEG KE 

KF KILOPACKET KF 

KG KILOGRAM KG 

KZ KILOWATT-HOUR KH 

KK 100 KILOGRAMS KK 

KT KIT KT 

KU TASK KU 

DK KELVIN KV 

L5 LITERS AT 15 DEGREES CELSIUS L5 (LOCAL CODE SUBMITTED FOR INCLUSION 
IN X12. REFER TO ADC 1108.) 

LB POUND (AVOIRDUPOIS) LB 

LE LITE LE 

LF LINEAR FOOT LF 

LO LONG TON LG 

LN LINEAR INCH LI 

LJ LARGE SPRAY LJ 

LK LINK LK 

LM LINEAR METER LM 

LG LENGTH LN 

LT LOT LO 

LR LAYER LR 

LS LUMP SUM LS 

LI LITER LT 

LY LINEAR YARD LY 

M0 MAGNETIC TAPE M0 

M3 MAT M3 

M5 MICROGRAM MC 

MD AIR DRY METRIC TON MD 

MG MILLIGRAM ME 

MJ METRIC GROSS TON MG 

MH METRIC MI 

MT MINUTE MJ 

ML MILLILITER ML 

MM MILLIMETER MM 

MA METRIC NET TON MN 

MO MONTH MO 

M6 METRIC TON MP 

MQ 1000 METERS MQ 

MR METER MR 

MS SQUARE MILLIMETER MS 

MK METRIC LONG TON MT 

MZ MIXED MX 
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N2 NUMBER OF LINES N2 

N7 PART N7 

N9 CARTRIDGE NEEDLE N9 

NB BARGE NB 

NC CAR NC 

ND NET BARRELS ND 

NE NET LITERS NE 

NF MESSAGES NF 

NG NET GALLONS NG 

NI NET IMPERIAL GALLONS NI 

NJ NUMBER OF SCREENS NJ 

NK NIGHTS NK 

NL LOAD NL 

NM NAUTICAL MILE NM 

NN TRAIN NN 

NS SHORT TON NS 

NT TRAILER NT 

NV VEHICLE NV 

NX PARTS PER THOUSAND NX 

GT THOUSAND GALLONS PER DAY NZ (X12 VERSION RELEASE 005030 
MIGRATION CODE. REFER TO ADC 1008.) 

OA PANEL OA 

OL OUTLET OB (X12 VERSION RELEASE 005030 
MIGRATION CODE. REFER TO ADC 1008.) 

OC BILLBOARD OC 

GX APOTHECARY GRAIN OG (X12 VERSION RELEASE 005030 
MIGRATION CODE. REFER TO ADC 1008.) 

OP TWO PACK OP 

OU OPERATING UNIT OU (X12 VERSION RELEASE 005020 
MIGRATION CODE. REFER TO ADC 1008.) 

OZ OUNCE - AV OZ 

P0 PAGE - ELECTRONIC P0 

P1 PERCENT P1 

P2 POUNDS PER FOOT P2 

P3 THREE PACK P3 

P4 FOUR PACK P4 

P5 FIVE PACK P5 

P6 SIX PACK P6 

P7 SEVEN PACK P7 

P8 EIGHT PACK P8 

P9 NINE PACK P9 

PL PAIL PA 

PB PAIR INCHES PB 

PC PIECE PC 

PD PAD PD 

PE POUNDS EQUIVALENT PE 
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PF PALLET (LIFT) PF 

PO POUNDS GROSS PG 

PH PACK (PAK) PH 

PY PITCH PI 

PG PACKAGE PK 

PJ PALLET/UNIT LOAD PL 

PS POUNDS NET PN 

PM PLATE PP 

PR PAIR PR 

PT PINT PT 

PU MASS POUNDS PU 

PV HALF PINT PV 

PP PINT IMPERIAL PX 

PK PECK DRY US PY 

PQ PECK DRY IMPERIAL PZ 

ME MEAL Q3 

FY FIFTY Q4 

TF TWENTY-FIVE Q5 

TS THIRTY-SIX Q6 

TD TWENTY-FOUR Q7 

FV FIVE Q9 (X12 VERSION RELEASE 005030 
MIGRATION CODE. REFER TO ADC 1008.) 

QC CHANNEL QC 

QU QUARTER DOZEN QD 

QE PHOTOGRAPHS QE 

QF QUARTER QF ** 

QK QUARTER KILOGRAM QK 

QR QUIRE QR 

QS QUART DRY U.S. QS 

QT QUART QT 

QI QUART IMPERIAL QU 

R4 CALORIE R4 

R5 THOUSANDS OF DOLLARS R5 

R9 THOUSAND CUBIC METERS R9 

RR RACK RA 

RB RADIAN RB 

RC ROD (AREA) - 16.25 SQUARE YARDS RC 

RD ROD (LENGTH) - 5.5 YARDS RD 

RL REEL RE 

RG RING RG 

RH RUNNING OR OPERATING HOURS RH 

RK ROLL-METRIC MEASURE RK 

RO ROLL RL 

RM REAM RM 

RN REAM-METRIC MEASURE RN 
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RE ROUND RO 

RP POUNDS PER REAM RP 

RS RESETS RS 

RT REVENUE TON MILES RT 

RU RUN RU 

RX THOUSAND ROUNDS RX 

S5 SIXTY-FOURTHS OF AN INCH S5 

S6 SESSIONS S6 

S7 STORAGE UNITS S7 

SW STANDARD ADVERTISING UNIT S8 

S9 SLIP SHEET S9 

SA SANDWICH SA 

M2 SQUARE MILE SB 

C2 SQUARE CENTIMETER SC 

SN SECTION (640 ACRES OR ONE SQUARE MILE) SE 

SF SQUARE FOOT SF 

SG SEGMENT SG 

SH SHEET SH 

SI SQUARE INCH SI 

SJ SACK SJ 

SR SPLIT TANKTRUCK SK 

SV SLEEVE SL 

SM SQUARE METER SM 

SU SQUARE ROD SN 

SL SPOOL SO 

S8 SHELF PACKAGE SP 

SQ SQUARE SQ 

SP STRIP SR 

SS SHEET-METRIC MEASURE SS 

SE SET ST 

SD SKID SV 

SK SKEIN SW 

SB SHIPMENT SX 

SY SQUARE YARD SY 

SZ SYRINGE SZ 

T1 THOUSAND POUNDS GROSS T1 

T3 THOUSAND PIECES T3 

T4 THOUSAND BAGS T4 

T5 THOUSAND CASINGS T5 

T6 THOUSAND GALLONS T6 

T7 THOUSAND IMPRESSIONS T7 

T8 THOUSAND LINEAR INCHES T8 

T9 THOUSAND KILOWATT HOURS/MEGAWATT-HOUR T9 

TA TENTH CUBIC FOOT TA 

TU TUBE TB 
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TC TRUCK LOAD TC 

TG GROSS TON TG 

MX THOUSAND TH 

TI THOUSAND SQUARE INCHES TI 

TJ THOUSAND SQUARE CENTIMETERS TJ 

TK TANK TK 

MF THOUSAND FEET TL 

TM THOUSAND FEET (BOARD) TM 

TN NET TON (2,000 POUNDS) TN 

TO TROY OUNCE TO 

TV TEN-PACK TP 

TQ THOUSAND FEET TQ 

TR TEN SQUARE FEET TR 

TZ THOUSAND SQUARE FEET TS 

TL THOUSAND LINEAR METERS TT 

TX THOUSAND LINEAR YARDS TU 

TH THOUSAND KILOGRAMS TV 

TW THOUSAND SHEETS TW 

TP TROY POUND TX 

TY TRAY TY 

MC THOUSAND CUBIC FEET TZ 

U1 TREATMENT U1 

TT TABLET U2 

TE TEN U3 

U5 TWO HUNDRED FIFTY U5 

U6 UNITED STATES GALLONS @ 60 DEGREES 
FAHRENHEIT 

U6 (MIGRATION CODE APPROVED FOR 
VERSION TO BE PUBLISHED JAN 2014. REFER TO 
ADC 1008.) 

UH TEN THOUSAND YARDS UH 

UL UNITLESS UL 

UM MILLION UNITS UM 

UN UNIT UN 

UP TROCHE UP 

UQ WAFER UQ 

AD APOTHECARY DRAM UX 

V1 FLAT V1 

V2 POUCH V2 

VC FIVE HUNDRED VC 

VI VIAL VI 

VS VISIT VS 

W2 WET KILO W2 

WB WET POUND WB 

WD WORK DAY WD 

WE WET TON WE 

WG WINE GALLON WG 
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WH WHEEL WH 

WK WEEK WK 

DW PENNYWEIGHT WP 

WR WRAP WR 

CH CHAIN X1 

X2 BUNCH X2 

X3 CLOVE X3 

X4 DROP X4 

X5 HEAD X5 

X6 HEART X6 

X7 LEAF X7 

X8 LOAF X8 

X9 PORTION X9 

Y1 SLICE Y1 

TB TABLESPOON Y2 

T2 TEASPOON Y3 

Y4 TUB Y4 

YD YARD YD 

YL 100 LINEAL YARDS YL 

YR YEAR YR 

Z1 LIFT VAN Z1 

Z2 CHEST Z2 

Z3 CASK Z3 

HH HOGSHEAD Z4 

Z5 LUG Z5 

PA PAGE ZP 

B2 BARREL, DRY ZW (X12 VERSION RELEASE 005020 
MIGRATION CODE. REFER TO ADC 1008.) 

B1 BARREL, LIQUID ZX (X12 VERSION RELEASE 005020 
MIGRATION CODE. REFER TO ADC 1008.) 

AS APOTHECARY SCRUPLE ZY (X12 VERSION RELEASE 005020 
MIGRATION CODE. REFER TO ADC 1008.) 
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5 Additional Information: General Text 
 
 

5.1 Overview 

Many fields, outlined in Section 3.2, include the use of “General Text” within their format. The permitted characters vary depending 
on the field; however, the acceptable characters to use in General Text are listed below. 

 
 

5.2 Permitted Characters 

Uppercase letters: A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Lowercase letters: a b c d e f g h i j k l m n o p q r s t u v w x y z 
Numerals: 0 1 2 3 4 5 6 7 8 9 
Symbols: {space} ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] _ ` { } ~ 

 
 

5.3 Prohibited Characters 

There are a number of characters that seem similar to those listed above but do not qualify as General Text. The following examples 
show common misuses of characters: 

 While the hyphen (-) character is permitted the em-dash (—) and en-dash (–) are not. 

 Regular double quotation marks (") must be used rather than special double quotation marks (“). The same rule applies for 
single quotation marks, regular (') versus special (‘). 
Note: Microsoft Office autocorrects regular quotation marks to special quotation marks, but this can be avoided by pressing 
Ctrl+Z (or “undo”) after typing the character. Notepad produces these characters in their correct form. 

 

The following characters are also prohibited: 

 Symbols: caret (^) and pipe (|) 

 Symbols greater than DEC 126 on the ASCII table 
Note: Users with technical backgrounds are likely to be familiar with the ASCII table. For unfamiliar users, the ASCII table can be 
accessed at https://www.ascii-code.com/ 

https://www.ascii-code.com/
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